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DIABLO ANALYTICAL, INC. 
SOFTWARE LICENSE AGREEMENT AND LIMITED WARRNTY 

 
LICENSE AGREEMENT 
 
IMPORTANT:  Please carefully read the License Agreement below before installing the software.  The right to use this 
software product is sold only on the condition that the customer agrees to the following license. 
 
INSTALLING THE SOFTWARE INDICATES YOUR ACCEPTANCE OF THESE TERMS AND CONDITIONS. 
 
In return for payment of the one-time license fee for this software product, Customer receives from Diablo Analytical, Inc. 
(Diablo) a license to use the product subject to the following terms and conditions: 
 
Use:  The product may be used on one computer or workstation. A separate license agreement and fee is required for 
each additional computer or workstation on which the product is used.  Customer may not reverse assemble, decompile, 
or modify the software. 
 
Copies:  The software product may not be duplicated or copied except for archive purposes, program error verification, or 
to replace defective media, and all copies made must bear the copyright notices contained in the original. 
 
Ownership:  Purchase of this license does not transfer any right, title or interest in the software product to Customer 
except as specifically set forth in this License Agreement.  Customer is on notice that the software product is protected 
under copyright laws. 
 
Transfer of Rights:  This license and the software product may be transferred to a third party, with prior written consent 
from Diablo, provided the third party agrees to all the terms of this License Agreement and the Customer does not retain 
any copies of the software product. 
 
Sublicensing and Distribution:  Customer may not sublicense the software or distribute copies of the software to the public 
in physical media or by telecommunication without the prior written consent of Diablo. 
 
Termination:  Diablo reserves the right to terminate this license upon breach.  In event of termination, Customer will either 
return all copies of the product to Diablo, or with Diablo's prior consent, provide Diablo with a certificate of destruction of 
all copies. 
 
Updates and Upgrades:  Customer agrees that the software does not include updates and upgrades which may be 
available from Diablo in a separate support agreement. 
 
Export Restrictions:  Customer agrees not to export or re-export the software or any copy in violation of the U.S. Export 
Administration regulations or other applicable regulation. 
 
LIMITED WARRANTY 
 
Limited Warranty:  Diablo warrants that the original disks are free from defects for 90 days from the date of delivery of the 
software. 
 
No Other Warranties:  To the maximum extent permitted by applicable law, Diablo expressly disclaims any warranty for 
the software product.  The software product and any related documentation is provided "as is" without warranty of any 
kind, either express or implied, including, without limitation, the implied warranties or merchantability of fitness for a 
particular purpose.  The entire risk arising out of use or performance of the software product remains with the customer. 
 
Limitation of Liability and Customer Remedies:  Diablo's entire liability and the customer's exclusive remedy under this 
license agreement shall be, at Diablo's option, either (a) return of the price paid for the software or (b) replacement of the 
software that does not meet Diablo's Limited Warranty and which is returned to Diablo with a copy of the customer's 
receipt.  Any replacement software will be warranted for the remainder of the original warranty period, or 30 days, 
whichever is longer.  These remedies are not available outside the United States of America. 
 
No Liability for Consequential Damages:  To the maximum extent permitted by applicable law, in no event shall Diablo be 
liable for any damages whatsoever (including, without limitation, damages for loss of business profit, business 
interruption, loss of business information, or any other pecuniary loss) arising out of the use or inability to use the product, 
even if Diablo has been advised of the possibility of such damages.  Because some states/jurisdictions do not allow the 
exclusion or limitation of liability for consequential or incidental damages, the above limitation may not apply to you. 
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Introduction 

EZReporter Overview 
Diablo’s EZReporter 4.0 software is a flexible, advanced, post-run analysis and reporting solution for any 
instrument that can be controlled by a supported chromatography data system. 

There are different Editions of EZReporter that can be licensed depending on your needs, starting with the 
Standard Edition, which includes the base feature set that is available with all other editions.  See “Licensing” 
on page 7 for a complete list of software editions and the modules that are included in each. 
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Standard Edition 

The Standard Edition can process calibrated peak results automatically from any supported chromatography 
data system. It allows for flexible reporting and exporting, parameter alarms, and history/trend plotting among 
other capabilities. 

• Multi-Channel Reporting: Results from multiple detector channels can be combined into a single 
report with both raw and normalized amounts (normalized across all channels) displayed. 

• Custom Calculations: You can create custom formulas using GC component results and other 
results. The results of the custom calculations can be displayed on the printed report, monitored, 
trend plotted, and exported to text files. 

• Easily Update the Component List: The list of components to process and report is completely 
customizable. Components can be added to or deleted from the component list. Natural Gas 
Analysis/Liquids calculation constants can be loaded from standard data sources or entered 
manually. 

• Data Export: Results can be exported to a text file for transfer to a Laboratory Information 
Management System (LIMS), Process Control System, or Microsoft Excel. The format of the text file 
can be customized easily using EZReporter’s flexible Export Templates. 

• Custom Sample Information: You can create custom sample information fields to include in the 
printed report, exported results, and data files. 

• Monitor Important Results: You can monitor important results and assign high/low visual alarms to 
notify you when those results exceed the limits. 

• Trend/History Plots: You can create trend plots of important results to see how they change with 
time. 

Optional Modules 

In addition to the standard functions described in this manual, EZReporter has a number of additional optional 
modules that add enhanced functionality.  Please refer to the reference manual for each module for 
information on how to configure and use that functionality. 

Natural Gas Analysis Module 

The EZReporter Natural Gas Analysis (NGA) Module is designed to perform standard Natural Gas and 
Refinery Gas Analysis heating value and related calculations. The results from these calculations are 
available for reporting, monitoring, trend plotting, and exporting. 

Natural Gas Liquids Module 

The EZReporter Natural Gas Liquids (NGL) Module is designed to perform standard Natural Gas Liquids 
extended analysis and reporting based on the GPA 2186-02 and GPA 2186-14 (and related) standards. The 
results from these calculations are available for reporting, monitoring, trend plotting, and exporting. 

Results Database Module 

The optional Results Database Module allows you to capture results and save them in a local SQLite 
database. Results in the database can be searched by sample name and date range and can be batch re-
processed for printing, exporting or trend plotting. 

Modbus Module 

The EZReporter 4.0 Modbus Module is an optional module that adds Modbus TCP Slave functionality to any 
of the EZReporter 4.0 editions. Most numeric results that are calculated and reported in the edition of 
EZReporter you are running can be assigned to a Modbus register for a Modbus Master to read. 
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System Requirements 
This software is supported on Windows 7 SP1, Windows 8/8.1, Windows 10, and Windows 11. 

The Microsoft .NET 4.7.2 Framework runtime must be installed. If the computer has an Internet connection, 
then the installer will automatically download the runtime if it is needed. If the computer is not connected to 
the Internet, then you will need to download the runtime file from our web site and copy it to the same folder 
as the installer before starting the installation. The runtime file is 526 MB in size. 

Note: if you are running a relatively recent version of Windows 10 (April 2018 Update - Version 1803 or later) 
or any version of Windows 11, then your system already has the runtime installed.   

Windows 11 Compatibility 

EZReporter 4.0 has been tested under Windows 11, and no significant issues have been identified to date.  
However, at this time some of the chromatography data systems used to control the Gas Chromatographs 
and provide raw component results to EZReporter may not yet compatible with Windows 11.  It is important 
that you check with the vendor of your chromatography data system before attempting to upgrade to Windows 
11. 

Windows Screen Resolution 

The software is designed to run best with the Windows screen resolution set to 100%.  We have made our 
best effort to ensure the software will run correctly on higher resolution displays, but if you have the screen 
resolution set to "Medium" (125%) or "Larger" (150%) or any scaling factor > 100%, some of the controls and 
windows may not display optimally. 

Windows 7:  right-click the desktop and select “Screen Resolution” from the popup menu.  Then choose the 
link, “Make text and other items larger or smaller”.  Choose, “Smaller (100%). 

Windows 10:  Right-click the desktop and select “Display Settings” from the popup menu.  Click the 
“Advanced Display Settings” option and then “Advanced sizing of text and other items”.  Click the “Set a 
custom scaling level” link and then set “Scale to this percentage of normal size: 100%”. 

Chromatography Data Systems 

In order for EZReporter 4.0 to process results automatically from a particular chromatography data system, a 
“Connector Plugin” must be written for that data system.  Please refer to the EZReporter release notes for the 
current list of supported data systems or contact Diablo Analytical for more information. 

EZReporter 3.0 Compatibility 
EZReporter 4.0 was designed so that it can be installed on the same computer as an existing EZReporter 3.0 
installation.  The two programs can be run side-by-side.  EZReporter 4.0 can open EZReporter 3.0 
configuration and data files. 

Note: you may need to make changes to the settings of the chromatography data system you are using in 
order to switch automatic processing back and forth between EZReporter 3.0 and 4.0.  Refer to the 
documentation for the connector plug-in for your chromatography data system for more information. 
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EZReporter 3.0 Configuration Files 

If you open an EZReporter 3.0 configuration file in EZReporter 4.0, it will be converted to the EZReporter 4.0 
format and saved with the same name in the EZReporter 4.0 settings folder.  You should review the results 
generated by the converted configuration file and confirm that reports and exported text files are correct for 
your application.  The converted files should produce equivalent results, but depending on the program 
features used, there may be some additional editing required. 

Known Compatibility Issues 

The following are the known compatibility issues with converted EZReporter 3.0 configuration files. 

1. Export Templates: If you use custom format strings for date/time export variables (InjectionTime, for 
example), you may have to change the format string.  See “Export Template Format” on page 61. 

2. Export Templates: Custom format strings for text export variables (SampleName, for example) are 
no longer supported.  You can use the new fixed-length field export capability to achieve the same 
results.  See “Export Template Format” on page 61. 

Installation 
EZReporter 4.0 is installed by running the setup program on the distribution flash drive/CD, or the installation 
program downloaded from our web site.   

Important:  You must be logged on with Administrator privileges when you install EZReporter (but you can 
run the software thereafter as a standard user) 

There are two different versions of the EZReporter installation program that can be downloaded from our web 
site: 

1. A web-based installer that should be used to update an existing installation of EZReporter 4.0 or to 
install the software on a computer that has Internet access.  This version of the installer will download 
the required .NET 4.0 Framework files automatically over the Internet if required. 

2. A single-file installer that should be used to install EZReporter on a computer with no access to the 
Internet.  This version of the installer includes the full .NET 4.0 Framework and is consequently much 
larger in size. 

Data System Support 

Make sure you download the version of the installation program that includes the data system connectors for 
the manufacturer of the chromatography data system you will be using to control your gas chromatograph. 

Installation and System Directories 

In order to comply with Windows 7 security guidelines, the folders used to store the various EZReporter 
program, data, configuration, and support files have changed from those used for EZReporter 3.0. 

Note: You can access and browse these folders using the “Tools > Browse EZReporter System Folders” 
menu option. 

Program Folder: Contains the EZReporter program executable, required libraries and other read-only 
support files.  The end user should not modify any files in this folder directly. 

 C:\Program Files (x86)\Diablo EZReporter 4.0 

Default Files Folder:  Contains configuration template files (.CFGT), and example export and import 
templates. 

 C:\ProgramData\Diablo Analytical\EZReporter\Default Files 

Settings Folder:  Contains the EZReporter configuration files (.CFG). 

 C:\Users\Public\Documents\Diablo EZReporter\Settings 
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Default Data Folder:  Contains EZReporter data files and is the default location for export text files. 

 C:\Users\Public\Documents\Diablo EZReporter\Data 

ProgramData Folder: Contains log files, and other support files that don’t need to be accessed directly by the 
end user. 

 C:\ProgramData\Diablo Analytical\EZReporter 

Common Documents Folder:  this folder contains all of the files that the end user should have to access on 
a regular basis.  It includes the “Settings” folder, the “Data” folder, the “Backup” folder, and the results 
database file. 

 C:\Users\Public\Documents\Diablo EZReporter 

EZReporter Manuals and Help 

This reference manual describes EZReporter 4.0 functionality that is common to all editions of the software.  
Depending on the program edition and add-on modules you have purchased, you may also need to refer to 
additional manuals and help files included with the software in order to complete the setup and configuration 
of the software for your application. 

Help files can be accessed from the “Help” option of the main program menu.  There are also context 
sensitive “Help” buttons displayed on many of the program windows. 

PDF versions of all manuals, including manuals for the installed connector plugins are located in the 
“Manuals” folder of the EZReporter installation folder and can be accessed easily via the “Help” menu (Help > 
View Software Manuals).   

Note: Manuals and corresponding help files are identical in content. 

All Editions: 

Refer to the EZReporter 4.0 Reference Manual for information on configuring the standard program options. 

Natural Gas Analysis (NGA) and Natural Gas Liquids (NGL) Modules: 

Refer to the NGA and NGL Modules manual for information on configuring and generating natural gas 
analysis reports. 

Results Database Module: 

Refer to the Results Database Module manual for information on configuring and using the optional Results 
Database. 

Modbus Module 

Refer to the Modbus Module manual for information on configuring and using the optional Modbus Module. 

Data System Connector: 

Refer to the manual for the “Connector” plugin for your chromatography data system to set up EZReporter to 
process results automatically at the end of your GC run.  Help files for specific connector plugins can be 
accessed either from the “Help” button on connector’s “Edit” window, or by right-clicking the corresponding 
instrument in the instrument table on the Sample Processing tab, and selecting the “Help” option. 

Software Licensing and Activation 
When you run EZReporter 4.0 for the first time, you will have a trial license that allows you to use and 
evaluate all of the program modules for up to 30 days.  The program is fully-functional during the trial period.  
In order to continue using the software after the 30-day trial period, you must purchase a license for the 
desired program modules, and then activate the software. 
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Important: Once the software has been activated, only the modules that were included in the license you 
purchased will be available. 

To activate your license, click the “Activate License” button on the License Status window that is displayed 
when you start the software or when you click the menu option, “Help > License Status…”. 

  

When you purchase your software license, you will receive a 31-character Serial License Code (this is 
different than the shorter Serial Number).  To activate the software, you must enter that License Code into the 
text box on the “Activate License” window.  If you copy the Serial License Code to the Windows Clipboard 
from an email message, you can paste into the text box using the “Paste” button.  Alternatively, if you 
received a text file containing the Serial License Code, you can load it using the “File Open” button. 

Note: If you received a distribution flash drive, the text file containing your serial license code may be saved 
on the flash drive. 
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After entering the Serial License Code, click the “Apply” button.  If your computer is connected to the Internet, 
the software will contact the License Server and automatically activate the software. 

If your computer is not connected to the Internet, or if there is a problem contacting the License Server, then 
you will need to activate the software manually by clicking the “Manual” button and following the instructions. 

After activating your license, EZReporter functionality will reflect the program modules that you licensed. 

Refer to the EZReporter Software License Guide for more information about licensing and activation. 

Note: An Internet connection is only required when applying an activation code or deactivating the software.  
No Internet connection is required during normal operation of the software. 

Licensing 

The following tables list the different “Editions” of EZReporter 4.0 that can be licensed, and the modules that 
will be available for each of those editions.  New in EZReporter 4.0 is a Data Analysis Edition.  The Natural 
Gas Liquids (NGL) functionality is now located in a separate module than the Natural Gas Analysis module 
and requires a separate license. 
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Software 
Edition 

Modules 

Standar
d 

NGA NGL RDB Processing Instrument
s* 

Data Analysis X X X   0 

Standard X    X 1 

Results 
Database 

(RDB) 

X   X X 1 

Natural Gas 
Analysis 
(NGA) 

X X   X 1 

Natural Gas 
Liquids (NGL) 

X X X  X 1 

NGA RDB X X  X X 1 

NGL RDB X X X X X 1 

*Contact Diablo Analytical for information on multi-instrument licenses. 

EZReporter 3.0 Software Upgrades 

Please contact Diablo Analytical to receive a quote to upgrade existing EZReporter 3.0 licenses to 
EZReporter 4.0.  The price will depend on 1) the number of licenses, 2) the edition you are upgrading from 
and upgrading to, and 3) the number of instruments you want to license. 

Software Support 

New EZReporter 4.0 licenses (including upgrades from EZReporter 3.0) include one year of software support.  
During the support period you will be able to install all upgrades of the EZReporter software (including major 
upgrades).  Once your software support has expired, you will not be able to install any upgrades released 
after the date your support expired.  However, you will be able to continue to use your existing version of the 
software – you just won’t be able to install any later upgrades until you renew support. 

The date that your software support expires is displayed in the “License Details” section of the License Status 
window.  When you are less than a month away from the expiration of your software support, a reminder will 
be displayed on the status bar at the bottom of the main EZReporter window.  Support renewal will take effect 
from the end date of the expired/current subscription, regardless of when the renewal is purchased. 

Please contact Diablo Analytical for more information on software support or to renew your support when it is 
expiring. 

Technical Support 
EZReporter 4.0 is developed and supported by Diablo Analytical, Inc. 

Diablo Analytical, Inc. 

5141 Lone Tree Way 

Antioch, CA  94531 

Phone: (925) 755-1005 

Fax: (925) 755-1007  

Electronic Mail 

Use our dedicated support address for e-mail based technical support: 
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support@diabloanalytical.com 

World Wide Web 

Access online support resources on our web site: 

http://www.diabloanalytical.com/support.htm 
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Getting Started 

Quick Start Instructions 
To get started with EZReporter 4.0 you will need to take the following steps: 

1. Select a configuration template to create a new configuration file. 

2. Review and edit the configuration 

3. Configure an instrument for processing (skip if you are using the Data Analysis Edition of EZReporter 
4.0) 

4. Enable sample processing (skip if you are using the Data Analysis Edition of EZReporter 4.0) 

Select a Configuration Template 

When you start EZReporter 4.0 for the first time, you will be asked whether to create a new configuration file 
from a template or load an existing configuration file. 

Create a new configuration file from template:  Choose this option if you don’t have an existing 
configuration file you would like to use.  You will be presented with the New Configuration File Wizard, which 
allows you to select the configuration template you want to use to create your new configuration file. 

Load existing configuration:  Choose this option if you have an existing configuration file you would like to 
use.  It should be saved in the EZReporter “Settings” folder. 

 

Create new configuration file from template 

The New Configuration File Wizard, allows you to select the configuration template you want to use to create 
a new configuration file.  Click the “Select Template Category” list box to view different sets of templates. 
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Note: If you are using the Standard Edition with no natural gas analysis calculations or reporting required, 
then choose the configuration template named, “STD Default.cfgt” which is displayed in either the “Common” 
or “Standard Edition” categories.  You will need to add the components from your GC method/report to the 
component table in the configuration editor.  See the EZReporter reference manual for more information. 

Note: Configuration templates in the “Obsolete” categories are using physical properties or are based on 
calculations that have been superseded by newer versions of the pertinent standard methods. 

After selecting the configuration template to use, click the “Next” button, and you will be prompted for a 
configuration file name, and the new configuration file will be saved and loaded. 
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Load an existing configuration file 

If you choose to load an existing configuration file, you can select either an EZReporter 4.0 configuration file 
(.CFGX) or an EZReporter 3.0 configuration file (.CFG) by clicking the file types list box. 

Note: if you choose an EZReporter 3.0 configuration file as the template, it will be converted automatically to 
an EZReporter 4.0 configuration file and saved in the EZReporter 4.0 settings folder.  The original EZReporter 
3.0 configuration file will not be modified. 
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Review and Edit the Configuration 

Once you have loaded a configuration file, you can review and edit the configuration by clicking the “Edit 
Configuration” button on the main toolbar or by clicking the “Tools > Edit Configuration…” menu option. 

 

To navigate the configuration editor, simply click the desired settings category at the bottom of the navigation 
bar, and then click the desired settings from the list that is displayed for that category. 

Important:  In order for EZReporter to identify the component results from the chromatography data system 
correctly, the component names in the EZReporter component table must match the spelling of the 
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corresponding component name from the GC results exactly (differences in capitalization are ignored).  See 
the EZReporter reference manual for more information. 

Configure Instrument for Processing 

After selecting and loading a configuration file, you must next configure EZReporter to process results from 
your chromatography data system. 

Add an Instrument 

First, you must add and configure an instrument.  Switch to the “Sample Processing” tab of the main window, 
and click the “Add” button below the instruments table. 

 

Select the Data System Connector 

In order to process results from your chromatography data system, you must select the Data System 
Connector for the data system you are using, and then “Edit” the connector to select and apply any 
connector-specific settings. 

Please refer to the reference manual or help file for the particular Data System Connector you are using. 

Important: The data system connectors available for you to select will depend on which version of the 
installation program you used to install the EZReporter 4.0 software.  Make sure that you download the 
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installer that includes support for the chromatography data system you are using to control your gas 
chromatograph. 

 

Enable Sample Processing 

After configuring the instrument, you are ready to begin monitoring the instrument and processing results.  
Check the “Monitor Instruments” checkbox to begin monitoring the instrument for results and processing 
results automatically as soon as they are received from the connector. 
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Start Instrument Monitoring Automatically 

If you want EZReporter to begin monitoring for results from all configured instruments automatically after 
starting up, click the “Configure” button in the Processing Control panel: 

 

In the “Configure Processing” window, check “Automatically Start Instrument Monitoring”, and “Save”: 

 

Processing Results 

With both “Monitor Instruments” and “Process Results” checked, EZReporter will process any results that 
have been added to the sample log table as they are submitted by the data system connector.  Processing is 
performed in the order added, and the table is checked for new samples on the sample processing interval 
specified in the Processing Control Settings. 
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Menus and Toolbars 

Main Toolbar 

 

The EZReporter toolbar provides quick access to the most commonly used program functions. 

Open Data File 

This button prompts you to select an EZReporter 3.0 or 4.0 data file and then processes it using the 
configuration file you choose (current, original, or embedded). 

Reprocess 

This button allows you to reprocess the current report. 

Print Report 

This button will send the current report to the printer. 

Save Report 

This button will save the current report to either an Adobe Acrobat PDF file or a Rich Text Format (RTF) file. 

Export 

This button will export the current results to a text file using the export template and other settings in the 
current configuration file. 

Load Configuration 
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This button will prompt you to select an EZReporter 3.0 or 4.0 configuration file and will load that file. 

Edit Configuration 

This button opens the configuration editor to edit the current configuration file. 

File Menu 

 

New Data File 

Select this option to create a new data file and manually enter component amounts and sample information. 

Open Data File 

This option prompts you to select an EZReporter 3.0 or 4.0 data file and then processes it using the 
configuration file you choose (current, original, or embedded). This option is the same as the Open Data File 
toolbar button. 

Save Data File As 

Select this option to save the current data and results to an EZReporter data file. 

Display Raw Results 

This option displays the current raw results including the sample information, original “raw” peak results, any 
sample information tags, and any processing log provided by the data system connector.  You can reprocess 
results from this window and use the original configuration file, the currently loaded configuration file, or the 
original configuration file if it is embedded in the data file.  See “Reviewing and Reprocessing Raw Results” 
on page 87 for more information. 

Reprocess Results 

This option allows you to update sample information and component results and then reprocess results.  The 
“Manual Data Entry” window will be displayed allowing the Sample Information and Component Amounts to 
be edited before processing. 

Note:  if the current results were acquired from a data system connector you will not be allowed to modify the 
component results unless the component was configured for manual entry. 
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Auto-report:  If this checkbox is checked, all reporting options specified in the configuration will be performed.  
If it is unchecked the calculations will be performed, and the main UI will be updated, but you will have to 
manually print the report, save the report to a PDF file, and export results to a text file.  See “Report Control” 
on page 70 for more information on automatic reporting. 

New Configuration File 

This menu option will display the New Configuration File Wizard, which allows you to choose the configuration 
template you want to use to create a new configuration file.  Once you have created a new configuration file 
from the template you can edit the configuration to customize it. 

Load Configuration File 

This option will prompt you to select an EZReporter 3.0 or 4.0 configuration file and will load that file.  This 
option is the same as the Load Configuration toolbar button. 

Export Results 

This button will export the current results to a text file using the export template and other settings in the 
current configuration file.  This option is the same as the Export toolbar button. 

Print 

The “Print > Report” menu option allows you to send the report to either the printer (Print > Report > Send to 
Printer) or save it to an Adobe PDF file (Print > Report > “Save as PDF).  These options are the same as the 
Print Report and Save Report toolbar buttons. 

Exit 

This option immediately closes the software. 
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Tools Menu 

 

Edit Configuration 

This option opens the configuration editor to edit the current configuration file.  This option is the same as the 
Edit Configuration toolbar button. 

Enable Debug Logging 

To enable debug logging, click this menu option.  Debug logging should only be enabled to troubleshoot 
specific problems with the software, and should be disabled when troubleshooting has been completed.  You 
can view the current log file in Windows Notepad by clicking the “View Current Log File” menu option. 

View Current Log File 

Displays the current log file in Windows Notepad.  This option is typically used when you have enabled debug 
logging for troubleshooting purposes. 

Configure Password Protection 

This option allows you to configure password protection of the configuration editor, instrument settings, and 
Modbus settings.  Once password protection has been enabled, you will need to enter an administrator 
password to access the resources you have selected for protection. 

 

After enabling password protection, you will be prompted to enter the administrator password the next time 
you try to access one of the protected resources: 

 

Note:  once you have entered the administrator password, “ADMINISTRATOR” will be displayed in the status 
bar at the bottom of the main EZReporter window: 
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While logged in as an administrator, you will not need to re-enter the password to access the protected 
resources.  To log out of administrator mode, you can either close and restart EZReporter, or click. “Tools > 
Log out Administrator”: 

 

Browse EZReporter System Folders 

This menu option provides access to several sub-menus that allow you to browse the various EZReporter 
system folders.  See “Installation and System Directories” under “Installation” on page 4 for more information 
about the system folders. 

Backup EZReporter Configuration 

This menu option backs up the current EZReporter configuration and log files into a backup “Zip” archive file.  
See “Back Up the Configuration” on page 91 for more information. 

Restore EZReporter Configuration 

This menu option allows you to restore an EZReporter configuration from a backup Zip file.  See “Restore the 
Configuration” on page 93 for more information. 

Help Menu 

  

View Help 

This option opens the EZReporter help file and displays the contents. Additional options may be displayed 
depending on which modules are active. 

View Software Manuals 

This option opens the folder containing the EZReporter manuals in PDF format. 

View Release Notes 
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This option displays the EZReporter release notes/readme text file in Windows Notepad.  This file contains 
information about the release of EZReporter that you are running including version/build information, a list of 
enhancements and fixes, and other information that may not be contained in the help file. 

Open Support Web Page 

This opens the EZReporter support page on the Diablo Analytical web site in the default browser: 

http://www.diabloanalytical.com/products/software/ezreporter/#support 

License Status 

This option opens the EZReporter License Status window where you can activate your software license.  See 
the EZReporter License Guide for more information. 

Check for Software Update 

If your computer has an active Internet connection, you can use this option to check if there are any updates 
to EZReporter available.  If an update is available, then the following window will be displayed: 

 

Click the “Display Update Readme File” link to download and display the “readme” file in Windows Notepad to 
see what changes have been made to the software.  If you decide to update the software, click the “Update” 
button.   

Important:  EZReporter will be closed automatically in order to install the update.  Make sure you are finished 
processing your current results before updating. 

In order to install the update, you will need to be logged in as an administrator.  If so, the software updater will 
be displayed allowing you to download and install the update.  Follow the instructions provided by the 
installer. 

http://www.diabloanalytical.com/products/software/ezreporter/#support
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About EZReporter 4.0 

Displays information about EZReporter including the current product and build version. 
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Sample Results Window 

 

The Sample Results tab contains the reported results divided into four tables: Sample Information, 
Component Results, Results Summary, and Errors and Warnings.  The content of each of these tables is 
described below.  To customize the results that are displayed in each table, see “Reported Results” on page 
76.  The results that are displayed in these tables are used to create the printed report.  See the example 
report below. 

Sample Information 

This section of the Sample Results contains the sample information: sample name, injection date, data file 
name, etc. 

Component Results 

This section of the Sample Results contains the component results 
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Results Summary 

This section of the Sample Results contains the summary/total results. 

Errors and Warnings 

This section of the Sample Results contains any errors or warnings that were generated by the data system 
connector or during processing of the results.  You can choose whether or not to include the errors and 
warnings in the printed report. 

Example Printed Report 

The printed report contains the same results displayed in the Sample Results tables: 
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Parameter Monitor Window 
This window shows the Parameter “Monitor” tab that displays the results from the last analysis for any 
monitored parameters.  High and low alarm limits can be set up for each monitored parameter. 

 

Floating Parameter Window 

You can display a “floating” parameter window that exactly mirrors the parameter table as it is displayed on 
the "Parameter Monitor" tab of the main UI.  This allows the parameter table to be displayed on a separate 
monitor or large LCD panel.  To enable/display the floating window, right click the main parameter table to 
display a pop-up menu, and click the "Display Floating Parameter Window" option.  To disable/hide the 
floating window, click the same menu option again.  The location and window state (maximized, normal, 
minimized) of the floating window will be saved and restored when you exit and restart EZReporter. 

Parameter History 

This window shows the parameter history tab that can be enabled to plot the historical values of any of the 
monitored parameters. 
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If you have enabled History Plots for any of the monitored parameters, then “Parameter” and “History” tabs 
will be displayed on the left side of the Parameter Monitor tab.  You switch back and forth between the history 
plot and the parameter table using these tabs. 

 

Reset 

Clears the current history data. 

Zoom Full 

Zooms the history plot so that all of the selected data can be viewed 

Options 

The Parameter History Options window allows you to modify some of the history plot display settings during a 
run.  Any changes you make to these settings will be written to the configuration file so that they are used the 
next time a sample is processed.  See the “Setting Parameter Options” discussion under “Monitored 
Parameters” on page 49 for more information on these settings. 
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Copy 

Copies the current history plot as an image to the Windows clipboard. 

Print 

Prints the current trend plot and statistical summary table to the printer. 

Export 

Exports the current history data to a comma-delimited text file. 
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Configuration Editor 

Configuration Editor Overview 
All of the settings that are used to define the calculations, customize the report format, and determine what 
actions are performed when processing results are defined within the configuration file.  The configuration 
editor is used to modify those settings.  The configuration editor can be opened either by clicking the “Edit 
Configuration” toolbar button or the “Tools > Edit Configuration…” menu option. 

 

The configuration editor uses a navigation bar located on the left side of the window to choose the settings to 
edit.  The navigation bar is divided into several groups, “General Settings”, “Report Settings”, and if you have 
one of the optional modules activated you will also see “Natural Gas Analysis” or “Results Database”.  Click 
on the button at the bottom of the navigation bar to select the options for that particular group of settings, and 
then click on the desired option in the list to display the settings you want to edit.  Once you are done editing 
the settings make sure to click the “Save” or “Save As” button to save your changes. 

See Also: 

Configuration Files 

General Settings 
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Report Settings 

Configuration Files 
EZReporter 4.0 configuration files are XML files with either a “.CFGX” file extension (configuration files) or a 
“.CFGT” file extension (configuration template files).  Configuration template files are used to create new 
configuration files with the “New Configuration File Wizard”.  A number of default configuration template files 
are installed with the software. 

Configuration files are stored in the folder, 

C:\Users\Public\Documents\Diablo EZReporter\Settings 

Configuration Template Files 

Configuration template files are stored separately from the configuration files in the folder, 

C:\ProgramData\Diablo Analytical\EZReporter\Default Files 

Whenever the EZReporter software is installed or upgraded, the default template files will be updated to be 
compatible with the version of EZReporter being installed.  However, configuration files created from the 
template files are not overwritten or modified during installation as could be the case with EZReporter 3.0. 

EZReporter 3.0 Configuration Files 

EZReporter 4.0 can load EZReporter 3.0 (.CFG) configuration files.  The .CFG file will be converted 
automatically to an EZReporter 4.0 .CFGX file and saved in the EZReporter 4.0 Settings folder.  The original 
EZReporter 3.0 .CFG file is not modified in any way. 

To load an EZReporter 3.0 configuration file, click the “Files > Load Configuration…” menu option, and then 
select “EZReporter 3.0 Files (*.cfg)” in the file types list box.  Then, browse to the folder containing your 
EZReporter 3.0 data files (usually C:\Program Files (x86)\Diablo EZReporter\Settings). 



Configuration Editor 

Diablo EZReporter 4.0 Reference Manual 33 

 

 

General Settings 
The General Settings contains the configuration settings for functionality that applies to all editions of 
EZReporter.  Click the “General Settings” button at the bottom of the navigation bar on the left side of the 
configuration editor, and then choose the specific type of setting you want to edit from the list. 
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Component Settings 

The components settings are used to manage the list of components that will be included in the calculations 
and report.   

 

Component Name 

The component names entered in the components table will be displayed in the component summary tables 
and reports. 
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Important:  If you are going to be processing data from a chromatography data system, then you must make 
sure that the names in the EZReporter component table match the names in the chromatography data system 
calibration/report exactly. 

Component ID 

The Component ID is a unique identifier that is assigned to a component when it is first added to the 
component table.  The ID is used to identify the component in export template variables, calculated result 
formulas and other related functions. 

Component Type 

Indicates whether the specified component is a normal Peak Result, a Reporting Group, or a Calculated 
Component as described below. 

Peak Result:  This is the normal component whose raw amount is provided by the chromatography data 
system. 

Reporting Group:  A reporting group is comprised of multiple Peak Result components.  The reporting group 
is only displayed in the component table on the main sample report and is intended to simplify reports 
containing a large number of components by grouping them together.  The component results displayed for 
the group in the component results table are the sum of the individual components that comprise the group.  
Only the component results displayed in the report are calculated and included in the reporting group.  
Reporting Groups can’t be used for any other purpose.  To edit the components in the reporting group, click 
the [...] button that is displayed on the right edge of the "Component Type" cell in the component table and 
then check the individual components to include in the group.  You have the option to exclude the 
components in included in the group from the report. 
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Calculated Component:  A Calculated Component is a component for which the raw amount is calculated 
from a formula rather than deriving from a standard peak/group result.  The formula used to calculate the 
amount can include the raw amount, peak area, and user constant from other components or numeric sample 
information fields.  To edit the calculated component formula, click the [...] button that is displayed on the right 
edge of the "Component Type" cell in the component table and then enter the formula. 
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Manual Amount Entry 

Check this box if you are using the software to generate reports automatically from a chromatography data 
system, and you need to be able to enter the specified component mole percent based on the results of a 
separate analysis.   

When results from the data system are processed, a “Manual Data Entry” window will be displayed, allowing 
you to enter the component's un-normalized amount, which will then be included in subsequent calculations. 
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Exclude From Report 

If this checkbox is checked, the specified component isn't displayed in the component results table in the 
main sample report.  However, it is included in normalization and calculations. 

Exclude From Calculations 

If this checkbox is checked, the specified component is not included in the normalization and subsequent 
NGA/NGL calculations.  Only the peak retention time, peak area, and raw amount will have non-zero values. 

User Tag 

A user-defined text "Tag" associated with a particular component that can be displayed in the component 
table on the report or exported to text files. 

User Constant 

A user-defined numeric constant associated with a particular component that can be displayed in the report, 
exported to text files, used in calculated result formulas, or displayed as a monitored parameter. 

Adding new components 

Press the "Add" button to add a new row to the component table manually.  Then, select the type of 
component you want to add (peak result, reporting group, or calculated component).  The row will be added 
below the currently selected row. Enter the component name and calculation factors for the new component. 
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Deleting existing components 

To delete components from the component list, select the rows containing the desired components and press 
the "Delete" button". 

Important:  When you delete the selected Components, any monitored parameters or other results that 
reference these Components will also be deleted.  In addition, any calculated result formula or export 
template that includes variables referencing these Components will no longer generate valid results and will 
need to be edited. 

Changing the component order 

The order of the components in the component settings table is the order that they will be printed in the 
report.  You can easily rearrange the component order by left-clicking the Component ID in the table and 
dragging it to the new position. 

Clearing the table 

Press the “Clear” button to delete all components from the component table. 

Undoing changes to the component list 

Press the “Undo” button to return the component list to the last saved configuration. 

Component Table Context Menu 

The following context menu will pop up when you right click with the cursor anywhere in the component table: 

 

Add new component below:  Clicking this option will result in a new blank line being added to the 
component table directly below the currently selected line. 

Clone selected component below:  Clicking this option will result in a new line being added to the 
component table directly below the currently selected line.  All of the component physical property data and 
other settings will be copied from the selected component.  The cloned component name will have a “*” 
appended to it as a reminder that you need to rename it (duplicate component names are not allowed). 

Delete selected component:  Clicking this option will delete all of the currently selected components. 
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Sample Information 

The Sample Information Fields options allow you to enable and configure custom sample information fields 
that can be used to report additional conditions like well number, pressure, temperature, etc.  They are simply 
a way for the user to enter additional custom information during an analysis, and have that information printed 
on reports and saved in the data and export files. 

 

Check the “Enable custom sample information fields” checkbox to enable the custom sample information 
fields.  Press the “Add” button to add a new sample information field, or the “Delete” button to delete the field 
that is currently selected.  The captions are displayed on the printed report, and when you are prompted to 
enter the associated custom sample information.  You can also specify whether the field is numeric. 

Default Value 

A default value can be specified for each of the custom sample information fields.  The default value will be 
displayed automatically when the Sample Information dialog box is displayed.  However, if the “Recall” option 
is set and a previous value exists for the field, then the previous value will be displayed instead of the default 
value. 

Select From a List of Items 

You can specify a list of items to select from in a custom sample information field.  Set the "Default" value in 
the sample information table of the configuration editor to the list of items separated by the "pipe" character 
(|).  The list must start with "<" and end with ">".  If you place a pipe character immediately after "<", then a 
combo box is used display the list, allowing the user to enter any text.  For example, <|Item 1|Item 2|Item 3>.  
Otherwise, a list box is displayed and the user can only select from the listed items.  For example, <Item 
1|Item 2|Item 3>. 
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When the “Manual Data Entry” form is displayed during sample processing and you click the sample 
information field, the list will be displayed:  

 
 

Custom Instrument Sample Information Variables 

Some of the EZReporter data system connectors will import additional sample “tags” from the results provided 
by the chromatography data system.  These tags are not available from every data system and the available 
tags may change based on your data system method settings.  However, if those sample tags are available, 
you can set the “default value” of a sample information field to a sample information variable to display the 
value of a sample tag. 

The format of the sample information variable is:  {TagName} 

To see what sample tags are available from your data system, double click a result in the Sample Processing 
Log of the Sample Processing tab of the main EZReporter window.  The Raw Results window will be 
displayed.  Switch to the “Sample Tags” tab.  Any available sample tags will be displayed in this window: 
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So the sample information variable you would use to display the “Processing method:” sample tag is: 

{Processing method:} 

The tag name must be entered exactly as it appears in the Sample Tags table. 

Hint:  You can select the desired Tag in the Sample Tags table and right-click to display a menu option to 
copy the selected Tag to the Windows Clipboard.  You can then past the Tag into the Sample Information 
variable. 

 

When the “Manual Data Entry” form is displayed during sample processing the value of the sample tag will be 
displayed: 
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Numeric Sample Information Fields 

If a sample information field is numeric, special numeric formatting and scaling can be applied to the value in 
the export file. 

Recall Last Value 

Check the “Recall” check box if you would like the last value entered into this field to be recalled when the 
form is displayed. 

Report 

If the “Report” checkbox is checked, then the field will be displayed in the “Sample Information” section of the 
report.  If it is unchecked, then the field will not be added to the report.  

Disable Prompt during Processing 

Check this option if the data system connector plugin you are using supports sample information variables 
and you don’t want to be prompted to enter sample information manually. 

Changing the order of Sample Information Fields 

The order of the fields in the sample information table is the order that they will be printed in the report and 
displayed in the sample information prompt.  You can easily rearrange the field order by left-clicking the field 
ID in the table and dragging it to the new position. 

Sample Information Rules 

The Sample Information Rules allow certain raw sample information results reported by the 
instrument/connector to be replaced with alternate text based on a set of rules.  You must first select the 
result you want to edit in the “Results” list:  
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Sample Information Mode 

The default Sample Information mode is “Use original value from raw results”.  When this option is 
selected, no change will be made to the value reported by the instrument connector for the selected result. 

To create a set of rules for the selected result, you must select he “Use rules to replace original value”, and 
then click the “Add” button to define a new rule. 

Sample Information Replacement Rules 

After adding a new rule, you must select the condition (Equals, Contains, Starts with, Ends With, and Is Like), 
and enter the Condition Text, and the Replacement Text to use if the rule is a match. 
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Result:  You can base the rule on the Sample Name, User Name or Comments/Sample Info/Miscellaneous 
Info. 

Condition:  Rule conditions include, “Equals” (the result matches the condition text exactly), “Contains” (the 
result contains the condition text), “Starts With” (the result starts with the condition text), “Ends With” (the 
result ends with the condition text), and “Is Like” (use pattern matching): 

The pattern-matching features allow you to match each character in the result against a specific character, a 
wildcard character, a character list, or a character range in the condition text. The following table shows the 
characters allowed in pattern and what they match. 

 

? Any single character 

* Zero or more characters 

# Any single digit (0–9) 

Condition Text:  The text string that is used for the comparison with the result. 

Replacement Text:  The text that will replace the value of the selected result if the rule is a match. 

Notes: 

1) The rules are not case sensitive, so “CAL” is treated the same as “Cal”. 
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2) You can define multiple rules for each result.  The rules are processed in the listed order.  The 
replacement text from the first rule that is a match will be applied to the result.  To change the order of 
the rules, left-click the blank cell in the first column (to the left of the result name) for the desired rule, 
and drag it to a new location in the table. 

3) The rules are only evaluated when processing raw results from the instrument through the Sample 
Processing Table.  The rules are not applied when loading EZReporter data files or reprocessing from 
the Results Database. 

4) You can use Sample Tags and some variables in the replacement text.  For example, the variable 
{Now} will be replaced by the current data and time.  You can generally use sample information 
variables that are derived directly from the raw results. 

Example Sample Information Replacement 

For example, for the rule shown above, if the Sample Name Equals "Cal" it will be replaced with "Calibration 
Sample" followed by the current date and time because of the {Now} variable. 

Here is the Manual Data Entry Window with the replacement text displayed for the Sample Name: 

 

Similarly, the Sample Name result will contain the replacement text in the Sample Information table: 
 

 

In addition, a “Warning” will be displayed in the “Errors and Warnings” table to notify you that the Sample 
Name result was replaced by rule: 
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Calculated Results 

Calculated results are based on custom formulas you enter using the “Formula Builder”.  The Formula Builder 
allows you to select from a list of available result variables and supported arithmetic operators to build a 
custom formula that will be evaluated to a numeric value when processing results.  The Calculated Result is 
then displayed in the Results Summary part of the report along with a descriptive caption that you also 
specify. 

Calculated Results can also be used as Monitored Parameters for alarming and trend plotting and both the 
caption and value can be specified in an Export Template and exported to a text file. 

 

Adding Calculated Results to the Configuration and Report 

To add a Calculated Result to the configuration and report: 

1. Click the “Add” button. 

2. In the new line that is added to the Calculated Results table, enter a caption that describes the result.  
This caption will be displayed along with the calculated value in the “Results Summary” section of the 
report. 

3. Click the […] button that is visible when you click in the “Formula” cell to display the Calculated Result 
Formula Builder and create the custom formula. 

4. Check the “Report” checkbox if you want this Calculated Result displayed in the report. 

5. Enter the desired numeric format string for this result. 

Creating a Custom Formula using the Formula Builder 

You create a custom formula for a Calculated Result using the Formula Builder tool that is displayed by 
clicking the […] button when the cursor is in the Formula cell of the Calculated Results table. 

Formulas consist of Result Variables and arithmetic Operators (+,-,*, etc.).  Simply double click the desired 
Result Variable or Operator from the respective list and it will be inserted at the current cursor location in the 
“Current Formula” box. 
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If the Result Variable you have selected is a Component Result, you will also be prompted to select the 
desired component. 

 

Once you have created the custom formula you can check that the syntax is valid by clicking the “Check 
Syntax” button.  If the formula syntax is invalid, an error message will be displayed: 
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If the formula syntax is valid, the result of the calculation will be displayed.   Note that the result of the 
calculation will be 0 unless there is a current report with actual results displayed in the main EZReporter 
Sample Result window in which case it will use the actual result values in the calculation. 

 

Changing the order of Calculated Results 

The order of the Calculated Results in the table is the order that they will be displayed and printed in the 
report.  You can easily rearrange the order by left-clicking the ID in the table and dragging it to the new 
position. 

Monitored Parameters 

The “Monitored Parameters” option allows you to configure a list of component or calculated results that will 
be displayed in the “Parameter Monitor” window of the main software screen.  You can set both high and low 
alarm limits for these monitored parameters – if the parameter value exceeds either of these limits, the result 
will be displayed with a red background in the parameter table to alert you. 

 

Options:  Clicking the “Option” button displays the Monitoring Options dialog box.  See “Setting Parameter 
Options” on page 50. 

Add:  Clicking the “Add” button allows you to configure and add a new parameter to the monitored parameter 
table.  See “Adding or Editing Parameters” on page 52. 
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Edit:  Clicking the “Edit” button allows you to edit the options for the parameter that is currently selected the 
parameter table.  You can also double-click the desired row in the table to edit a parameter’s options.  See 
“Adding or Editing Parameters” on page 52. 

Delete:  Clicking the “Delete” button will remove the selected parameter from the parameter table. 

Clear:  Clicking the “Clear” button will clear the parameter table. 

Undo:  Clicking the “Undo” button will restore the parameter table to the last saved configuration. 

Help:  Clicking the “Help” button displays context-sensitive help for this topic. 

Changing the Display Order of Parameters 

To rearrange the order of the parameters in the parameter table, left-click the parameter number of the 
desired parameter in the first column of the table and drag it to a new location in the table. 

Clone Selected Parameter 

Right clicking on a parameter in the table displays a context menu that allows you to clone the properties of 
the selected parameter to a new parameter.  This allows you to create a new parameter quickly using an 
existing parameter as a template. 

Automatically Add Remaining Components 

Right clicking on a component parameter table displays a context menu that allows you to add the remaining 
components in the configuration to the parameter table using the selected component parameter as the 
template. 

Setting Parameter Options 

Click the “Options” button to set additional options for Parameter Monitoring. 

Parameter Options 

The parameter options allow you to configure the displayed parameter table and also generate an optional 
parameter report. 
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Parameter Display 

You can change the parameter display font by clicking the font button and choosing the desired font, style, 
and size. 

Check the “Display alarm limits and status” option if you would like to include the actual upper and lower 
alarm limits in the parameter table along with the parameter name and value.  This can be especially useful 
when using relative alarm limits so that you can see the actual calculated limits for each parameter. 

Parameter Report 

You can have a parameter report included with any EZReporter printed report by checking the “Print 
parameter report” option.  The report can either be included immediately after the standard report, or you can 
specify to have it start on a new page.  You can also include only parameters that have exceed an alarm limit 
and have “Failed” status. 

History Options 

The history options allow you to configure the trend/history plot for any parameters that have been enabled for 
plotting. 
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Enable Parameter History Plots:  Check this box to enable history plots for the monitored parameters.  Note 
that this option will be set automatically if history plots are enabled for any of the individual parameters. 

X-Axis Data Source:  You can choose to plot the parameter values against a sequential data point/run 
number, the current time when the report/results are generated, or the injection date/time of the 
chromatographic run. 

X-Axis Scroll Window: The X-Axis will automatically zoom to this time (in minutes) or data point window.  
When new results are received, older data points outside this window will no longer be visible.  However, the 
entire history plot can be displayed at any time by clicking the “Zoom Full” button, or double-clicking on the 
plot window. 

Y-Axis Scaling:  You can choose to have the y-axis scale adjusted automatically so that the range includes 
only the data points that are visible in the current plot/window.  Alternatively, you can choose to have the y-
axis scale adjusted so that it represents the full range of parameter values, including those outside the current 
plot/window. 

Parameter Series Display Mode:  You can display each parameter history plot series either individually or 
with all series overlaid on the same axes. 

Adding or Editing Parameters 

Click the “Add” button to add a new parameter or the “Edit” button to edit the parameter currently selected in 
the parameter table (you can also double click the line in the table that you want to edit).  You can also clear 
the current table by pressing the “Clear” button, or undo any changes you have made to the table by pressing 
the “Undo” button. 
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Parameter:  Select the parameter that you want to monitor from this list box.  If you select a parameter that is 
derived from a component result (component amount, for example), then you will also need to specify the 
corresponding component from the component list box. 

Note that if the NGA/NGL Module is active, the parameter list will include a number of different NGA-related 
result parameters.  If the NGA module is not active, only chromatographic parameters like retention time, 
peak area, and amount will be listed. 

Component:  If you select a parameter that is derived from a component result (component amount, for 
example), then you will also need to specify the corresponding component from the component list box. 

Parameter Display Format:  You can set the numeric formatting for the displayed parameter value by 
entering a format string in this text box.  Examples of common formatting strings are shown in the table below. 
 

Format String Result 

0 Will display all digits to the left of the decimal point and no digits to the right: 

The value 10000.2324 will be displayed as 10000 

The value 0.2324 will be displayed as 0 

0.00 Will display all digits to the left of the decimal point and two digits to the right of the 
decimal place: 

The value 232.4012 will be displayed as 232.40 

The value 232 will be displayed as 232.00 

0.0### Will display all digits to the left of the decimal place, and from 1 to 4 digits to the 
right of the decimal place: 

The value 232.4012 will be displayed as 232.4012 

The value 232.4 will be displayed as 232.4 
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The value 232 will be displayed as 232.0 

 

Set Default:  If you click the “Default” button, the default formatting string for this type of parameter will be 
copied into the format text box for you. 

Display Name:  The text entered into the “Display Name” text box will be displayed for this parameter in the 
Monitor Table.  You can click the [<] button to copy text from the parameter and component (if appropriate) 
list boxes into the text box. 

Enable History Plot for this parameter:  If you check this box, then the value of this monitored parameter 
will be plotted in the Parameter History display. 

Parameter Alarms 

You can enable both high and/or low parameter alarms by checking either one or both of these check boxes 
and selecting the desired alarm type/limit. 

Fixed Alarm Limits 

With the “Fixed alarm limits” alarm type you simply enter the upper and lower values for the alarm limits. 

 

Relative Alarm Limits 

With “Relative alarm limits” you must enter an alarm value and the limits are calculated relative to that value.  
You can specify whether you want the limits calculated as a percent relative to the Value (Value +/- %Limit of 
the Value) or use absolute limits (Value +/- Limit). 
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Sample History Alarm Limits 

Important:  This option is only available in trial mode or if your license includes the Results Database Module.  
In addition, the “GPA 2261” limit options will only be enabled if your license includes the Natural Gas Analysis 
Module. 

Sample History Alarms Limits allow you to set alarms based on the historic average and standard deviation of 
samples stored in the Results Database. 

 

The average (“Avg.”) and standard deviation (“Std. Dev.”) used to calculate the limits are determined by 
searching the results database for results with sample names matching the current result.  By default, the 
search will use the filters from the Results Database Sample Processing “History” settings (see the Results 
Database reference manual for more information.) 
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However, you can also uncheck the default option and set specific history filters for this sample to limit the 
number of results returned by the search to the last ‘n’ results, or the last ‘n’ days, weeks, months, or years.  
You can further limit the results based on the Result Status. 

The “GPA 2261” limit options compare the value of the current parameter with the historical average of the 
parameter using the GPA 2261 reproducibility and repeatability limits (see the NGA and NGL Module 
Reference for more information.) 

Text Alarms 

Text alarms are available when the chosen parameter is a non-numeric, text result like “Sample Name”.  If 
you enable the Text Alarm, the alarm will be triggered when the parameter text matches the alarm condition 
defined by the “Alarm Text” and the “Alarm when” setting.  The comparison is not case sensitive.  You can 
also specify a reverse comparison (Not Equal, Does Not Contain, etc.). 

 

Text Export 

The EZReporter software includes a flexible text export feature that allows you to create custom text files in 
almost any format you might need.  An export template file defines the format of the export file. 
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Export Control 

Export Options 

Check “Enable automatic export of results” if you want the results from a chromatography data system to 
be exported automatically when the data is processed by the EZReporter software. 

Check “Append results if export file exists” if you want the exported results to be appended to any results 
that already exist in the specified export file.  If this option is unchecked, then existing results will be 
overwritten. 

Check “Export null instead of 0 if component amount not measured” if you are required to export a 
component amount of 0 only if the amount was measured.  EZReporter determines if a component has been 
measured if it is included in the results from the GC (even if the amount is 0), entered manually in the manual 
data entry window (even if the amount is 0), or is the result of a calculated result.  If this option is enabled and 
the component amount hasn’t been measured, then a null (blank) is exported instead. 

Automatic Processing Control 
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These settings define how results will be exported when processing results automatically. 

Export all results:  All results will be exported according to the export control settings and export template. 

Export only results with no failed alarms:  If alarms are enabled for any of the parameters in the Monitored 
Parameters table, then only results with no failed alarms will be exported. 

Display confirmation window before exporting result:  A confirmation window will be displayed allowing 
you to review the monitored parameters and alarms.  Check the option, “Display only if there are failed 
alarms” and the confirmation window will only be displayed if there are one or more failed parameter alarms.  
Check the option, “Require comment to export result with failed alarm”, and the user must enter a result 
comment in order to accept the result and export.  The result comment is available in the result variable, 
{ResultComment}. 

Note:  If the confirmation window option is selected for both Export Control and Results Database Processing, 
then it will not be shown for export unless there is additional information required that wasn't collected by the 
results database window (specifically, the result comment). 
 

\ 

Note: You can have a set of pre-defined result comments loaded automatically into the Result Comments list 
box by adding those comments to a file named, 

C:\Users\Public\Documents\Diablo EZReporter\ResultComments.dat. 

If this file is found, each line of text present in the file will be added as a separate item in the list box. 

Export Directory 

Click the “Open” button to select the directory to which export files will be saved. 

Export File 

These options are used to specify the export text file name.  You can choose to name the export file based on 
the name of the EZReporter data file (see the “Data Files” settings), or you can enter a “fixed” file name.  If 
you choose the first option, the export file will have the same base file name as the data file. 
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You can also have the export file named based on the sample name.  This allows results from replicate runs 
of the same sample to be added appended to the same export file even though the data file names are 
different. 

Export File Extension:  Enter the file extension to use for the export file into this text box field.  The default 
extension if this field is left blank is “txt”. 

Note:  if you enter a fixed export file name that already includes a file extension, it will take precedence over 
the entry in the Export File Extension field. 

Export Template 

The Export Template defines the format of the text file that will be created when results are exported.  The 
Export Template uses “Export Variables” to determine where to place results from the report in the text file.  
Export variables are special text strings contained between curly braces.  Whenever the export engine 
encounters an export variable, the variable text is replaced by the actual value of the corresponding result. In 
the example below, the export variable, {SampleName}, is replaced by the actual sample name from the 
report.  Any text that is not part of an Export Variable is copied to the text file without modification. 

Note:  EZReporter 4.0 Export Templates are saved as part of the configuration file.  This is unlike EZReporter 
3.0 where they were contained in separate export template files.  This makes it easier to backup 
configurations and transfer them to other systems. 

 

Load an Export Template 

A default export template is loaded by default.  You can either edit the default template directly, or load a 
template from a file by clicking the “Load” button. 

Save an Export Template 

If you want to save the current export template to disk in order to share it with someone else, click the “Save 
As” button. 



Configuration Editor 

60 Diablo EZReporter 4.0 Reference Manual 

Export Template Editing Menu 

To edit an export template, place the cursor at the desired location in the template and right click to display 
the export template editing menu. 

 

Insert Export Variable 

To insert a variable into the template, select the type of variable (Sample Information, Component, 
Total/Summary, or Miscellaneous/Control) and then select the desired variable.  The export variable that will 
be inserted into the template is displayed in the “Current Variable” panel. 
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Edit Selected Variable 

If you place the cursor on a variable in the export template and select “Edit Selected Variable”, that variable 
will be displayed in the variable editor allowing you to modify or change the variable. 

Convert Tab Characters and Variables 

Tab characters are commonly used in export templates to create “tab-separated” or “tab-delimited” text files.  
Since tab characters are not visible in the template, you can instead use the {Tab} variable.  You can use the 
corresponding export template editing menu options to convert back and forth between tab characters and tab 
variables. 

Note: Tab characters and tab variables are treated exactly the same by the export engines, so you can use 
either interchangeably. 

Convert Comma and Tab Delimiters 

These options allow you to convert between tab or comma delimiter characters in the export template.  
Delimiter characters are used as “field separators” when the text file is imported into Excel, FlowCal, or other 
software. 

Convert Variable IDs and Indexes 

As of version 4.0.10, EZReporter uses a 4-digit ID code to identify components, calculated results, and 
sample information fields in the export template.  Prior to this version, an index number was used.  These 
options allow you to convert between variable indexes and IDs to help support older versions of the software. 

Word Wrap 

If you select this option the current template will toggle on or off word wrap display mode where long lines are 
wrapped so you don’t have to scroll the window.  This setting has no impact on the exported text – it is for 
display purposes only. 

Export Template Format 

The export function will replace any "variables" it finds within the export template file with the current value of 
the variable.  Variables are pre-defined names enclosed between braces: {VariableName}. 

Any other text that is present in the template file will be exported "as is" unless it is part of a comment or other 
special template section. 

 

{StartComment} 

Any text present between {StartComment} and {EndComment} will not be saved 

to the export file.  Comments can be used to annotate the template file. 

{EndComment} 

 

The lines between StartHeader and EndHeader will only be saved to a new export file.  They will not be saved 
when new results are appended to an existing export file. This can be used to create a column header for a 
summary list of results from multiple runs, for example. 

 

{StartHeader} 

Date, Name, Ret. Time, Area, Mole% 

{EndHeader} 
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"DecimalPlaces" is a special variable used to set the number of decimal places to include for calculated 
results (4 places in this example).  It affects the results that are exported after its place in the template.  Note 
that the default value is the number of decimal places specified in the Data Files configuration. 

Note:  It is generally best to change the number of decimal places to report using the option in the Data Files 
section of the EZReporter configuration editor rather than the “Decimal Places” variable. 

 

{DecimalPlaces,4} 

 

To create a comma-delimited export file, simply include commas between the fields you wish to separate.  In 
addition, if you want quotation marks to enclose text fields, simply include them in the template as shown 
below. 

 

"CurrentDate", "{Now}" 

"SampleName", "{SampleName}" 

"UserName", "{UserName}" 

 

To create a tab-delimited file, simply use the tab key on your keyboard, or include the special tab variable, 
"Tab", between the fields you wish to separate as shown below. 

 

CurrentDate {Now} 

SampleName {SampleName} 

UserName {UserName} 

 

or 

 

MethodName{Tab}{MethodName} 

SettingsFile{Tab}{SettingsFile} 

InjectionTime{Tab}{InjectionTime} 

 

You can use the special component loop to print the component-specific results (Name, Mole%, Area, etc.) 
for all of the components in the current configuration.  The components are exported in the same order that 
they appear in the configuration editor. 

 

{StartCompLoop} 

{CompName},{CompRT},{CompArea},{CompNormMolePct} 

{EndCompLoop} 

You can exclude components from being exported in a component loop by placing one or more instances of 
the special variable {ExcludeCompFlag, Flag} on a line by itself before the component loop.  The following 
flags are supported: 

 

Variable, Flag Description 
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{ExcludeCompFlag, RT} Exclude the component if its retention time is 0 

{ExcludeCompFlag, AMT} Exclude the component if its raw amount is 0 

{ExcludeCompFlag, AREA} Exclude the component if its peak area is 0 

{ExcludeCompFlag, REPORT} Exclude the component if “Exclude from Report” is checked in the 
component configuration. 

{ExcludeCompFlag, 1001} Exclude the component with the specified component ID (shown as 
“1001” in this case – replace with the actual ID) 

{ExcludeCompFlag, -1001} Force the component with the specified component ID to be included in 
the component loop export regardless of whether it is excluded by other 
flags.  Set the component ID to a negative value. 

{ExcludeCompFlag} Use the variable with no flag to reset all of previous flags to allow all 
components to be exported. 

 

If instead, you want to export the results for a specific component, simply include the component ID in the 
variable as shown below. The Component IDs are displayed next to the Component Name in the component 
table. 

 

Component 1 Name:  {CompName,1001} 

Component 1 Mole%: {CompNormMolePct,1001} 

 

You can use the special line continuation variable, "_", to force the next line in the template to be appended to 
the current line instead of in a new line: 

 

{CompName,1},{_} 

{CompName,2},{_} 

{CompName,3} 

 

Line continuation is most useful in instances where you want all of the results to appear in a single line.  For 
example, you would use the line continuation in a component loop to create a summary export file in which 
each line corresponds to a single run. 

 

{StartCompLoop} 

{CompName},{CompRT},{CompArea},{CompNormMolePct},{_} 

{EndCompLoop} 

 

Export Variable Format Strings and Scale Factors 

Optional formatting strings and scaling factors can be specified for export variables to increase flexibility. 

The export variable syntax is shown below: 

{VariableName, [PARAMETER], [FORMAT], [SCALEFACTOR]} 

VariableName:  The name of the variable. 
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[PARAMETER]:  An optional parameter value that is required for some variables. 

[FORMAT]:  A special format string that instructs the export engine on how to format the variable value before 
writing it to the export file. 

[SCALEFACTOR]:  If the variable is numeric, it will be multiplied by the specified scaling factor prior to 
formatting and writing the result to the export file. 

Important Note for EZReporter 3.0 Export Templates:  If you are using an export template that was 
originally developed for EZReporter 3.0, and you use custom format strings in your template, you may need to 
modify those strings since some of the custom formatting characters have change between EZReporter 3.0 
and EZReporter 4.0.  In particular: 

• The date format characters have changed for the month and minute.  See the table below for the new 
date/time format strings. 

• EZReporter 3.0 Text String Formatting is no longer supported.  See “Fixed Format Length and 
Alignment” below for instructions on how to accomplish the same formatting in EZReporter 4.0. 

The following table describes the special characters used to make up a format string. 

 

Format Character Description 

Numeric Formatting 

0 Digit placeholder. Display a digit or a zero. If the variable has a digit in the position where the 
0 appears in the format string, display it; otherwise, display a zero in that position. 

# Digit placeholder. Display a digit or nothing. If the variable has a digit in the position where 
the # appears in the format string, display it; otherwise, display nothing in that position. 

. Decimal placeholder.  The decimal placeholder determines how many digits are displayed to 
the left and right of the decimal separator. If the format expression contains only number 
signs to the left of this symbol, numbers smaller than 1 begin with a decimal separator. To 
display a leading zero displayed with fractional numbers, use 0 as the first digit placeholder 
to the left of the decimal separator. 

Date Formatting 

d Display the day as a number without a leading zero (1 – 31). 

dd Display the day as a number with a leading zero (01 – 31). 

ddd The abbreviated name of the day of the week (Mon – Sun). 

dddd The full name of the day of the week (Monday – Sunday) 

M Display the month as a number without a leading zero (1 – 12). 

MM Display the month as a number with a leading zero (01 – 12). 

MMM The abbreviated name of the month (Jan – Dec). 

MMMM The full name of the month (January – December). 

yy Display the year as a 2-digit number (00 – 99). 

yyyy Display the year as a 4-digit number (100 – 9999). 

Time Formatting 

h The hour, using a 12-hour clock from 1 to 12. 

hh The hour, using a 12-hour clock from 01 to 12. 

H The hour, using a 24-hour clock from 0 to 23. 

HH The hour, using a 24-hour clock from 00 to 23. 

m The minute, from 0 through 59. 

mm The minute, from 00 through 59. 

s The second, from 0 through 59. 
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ss The second, from 00 through 59. 

tt The AM/PM designator. 

 

Fixed Format Length and Alignment 

You can create fixed length numeric export fields by adding an alignment prefix to the format string: 

Length!Format 

For Example: 10!0.000 would format the number to three decimal places and pad the result with 
spaces so that it occupies 10 characters in the text file. 

For fixed length text export fields, simply specify the alignment prefix as the format string: 

Length! 

For Example: 10! would export the text field so that it occupies 10 characters in the text file. 

Additional Notes: 

• For right-justified text, the alignment length should be positive (10!). 

• For left-justified text the alignment length should be negative (-10!). 

• If the alignment length is less than the length of the text, the text will be truncated to the specified 
alignment length.  The text will be truncated from the end of the string if you use either the “!” or “>” 
alignment operator.  If you want to truncate the text from the start of the string, use the “<” alignment 
operator instead (10<) 

The following table shows a few examples of format and alignment strings and scaling factors. 

 

Variable Variable Value Value Exported 

{CompRawMolePct,1001,0.000} 1.523446 1.523 

{CompRawMolePct,1001,0.000} 85.67234 85.672 

{CompRawMolePct,1001,00000,1000} 85.67234 85672 

{CompArea,1002,00000000} 1234 00001234 

{InjectionTime} 10/12/2004 1:08:13 
PM 

10/12/2004 1:08:13 
PM 

{InjectionTime,,MMddyyyy} 10/12/2004 1:08:13 
PM 

10122004 

{InjectionTime,,HHmm} 10/12/2004 1:08:13 
PM 

2013 

{SampleName,,8!} Sample Name Sample N 

{SampleName,,8>} Sample Name Sample N 

{SampleName,,8<} Sample Name ple Name 

{SampleName,,-8!} RC1 RC1***** 

{CompRawMolePct,1001,10!0.000} 1.523446 *****1.523 

{CompRawMolePct,1001,-10!0.000} 1.523446 1.523***** 

 * = a space character 



Configuration Editor 

66 Diablo EZReporter 4.0 Reference Manual 

Miscellaneous Settings 

 

Component Amount Rounding 

Use this option to set the number of decimal places to round the component amount or mole percent values 
prior to their being used in calculations.  Component and related total amounts will also be displayed in the 
report using this number of decimal places. 

Important:  The normalized mole% values will be rounded to the number of decimal places specified in this 
setting before they are used in any calculations.  In addition, if rounding causes the total normalized mole% 
not to sum to 100%, then a correction is made to the normalized mole% of the most concentrated component 
in the sample (usually methane in NGA applications) to force the total to 100%. 

Result Rounding 

If this option is enabled, then the component results are rounded to the number of decimal places specified in 
each result's display format setting in the reported results table before calculating the total results.  This 
addresses a situation where sum of the component results displayed in the component table on the report 
would not exactly equal the total result due to rounding of the displayed component result. 

If this option is disabled (the default), then the total results are calculated using the full double-precision 
component results.  Certain results that are used in subsequent calculations (Molecular weight and 
Compressibility), are initially calculated at full, double precision, and then rounded after all other calculations 
have been completed. 

Note:  This option primarily applies to NGA/NGL calculated results and is not currently enabled for the ISO 
calculations. 

ISTD Amount Mapping 

This is an advanced option that isn’t supported by all data systems.  It allows you to map the Internal 
Standard Amount from an analysis to the raw mole% of one of the components.  This means that you can 
enter a result from another analyzer (e.g. H2S from a Draeger tube) into the chromatography data system 
sequence, and have it automatically applied to the specified component without requiring reprocessing or 
prompting. 

Note 1:  Some data systems will switch the ISTD Amount from 0 or blank to 1 in the sequence table.  
Consequently, you may need to enter a very small non-zero number for 0 (for example 0.000001). 

Note 2:  There may be additional method settings required to enable this capability. 
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Sample Tag Mapping 

This is an advanced option that isn’t supported by all data systems.  It allows you to map the value of a 
sample “tag” from a raw result to the raw mole% of one of the components.  This means that you can enter a 
result from another analyzer (e.g. H2S from a Draeger tube) into the chromatography data system sequence, 
and have it automatically applied to the specified component without requiring reprocessing or prompting. 

To determine what sample tags are available from your chromatography data system, open the raw results 
window by clicking either the “File > Display Raw Result” menu option or by double-clicking a sample in the 
sample processing log.  Switch to the “Sample Tags” tab to see the tags available to you.  Enter the desired 
tag name into the “Sample Tag” field exactly as it is spelled. 

 

EZReporter Data Files 

EZReporter 4.0 data files are XML files with either an “.EZRX” file extension (uncompressed data files) or an 
“.EZR” file extension (compressed data files).  Compressed data files are simply standard data files that have 
been compressed into a “Zip” file and then renamed with the “.EZR” file extension. 
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Default Data Directory 

Specify the directory into which you would like to save data files – use the "Browse" button to select or create 
the desired directory.  The default data directory in EZReporter 4.0 is: 

C:\Users\Public\Documents\Diablo EZReporter\Data 

Automatic File Saving 

Check this box if you would like to have a data file created in the default data directory during automatic 
processing of data from a chromatography data system. 

Data File Naming Options 

These options define how the data file name will be determined when it is created during processing. 

Use chromatography data system data file name 

If you choose this option, the data file will be named based on the source data file name generated by the 
chromatography data system.  The file will be named with the same base filename, but with the “.EZX” file 
extension instead of the “.DAT” file extension. 

Use Date-Time 

The data files are named using a Date + Time format: 

 YYYYMMDD-HHMMSS.EZX 

Where YYYYMMDD is the current date and HHMMSS is the current time (e.g. 20050208-153423.EZX). 
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Check this box if you would like to have the sample name added to the Date+Time formatted file name during 
automatic processing (e.g. NGA Sample-20050208-153423.EZX). 

Sample Name Options 

This option allows you to set whether the sample name is added before or after the file name.  Select “Before” 
(e.g. NGA Sample-20050208-153423.EZX) if you want the data files to sort alphabetically by sample name 
when you view the data file directory in Windows Explorer.  Select “After” (e.g. 20050208-153423-NGA 
Sample.EZX) if you want the data files to sort by the Date/Time. 

Report Settings 
Report Settings contains the configuration settings for controlling, customizing, and formatting the report.  
Click the “Report Settings” button at the bottom of the navigation bar on the left side of the configuration 
editor, and then choose the specific type of setting you want to edit from the list. 
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Report Control 

 

Default Automatic Reporting Settings 

These settings allow the default automatic reporting behavior to be modified.  The following reporting 
functions are executed when they are enabled in the configuration and when automatic reporting is also 
enabled: 

• Save the raw results to an EZReporter data file (see “EZReporter Data Files” on page 67). 

• Print the report to the default printer (see Report Control below). 

• Save the report to a PDF file (see PDF File Control below) 

• Run the post-processing program (see Post Processing Program below) 

• Export results to a text file (see “Text Export” on page 56) 

• Save results to the Results Database (see the Results Database reference manual) 
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Auto-report new instrument results 

Automatic reporting is enabled by default when processing new results submitted from instruments to the 
sample processing log.  If you uncheck this option, then automatic reporting will be disabled. 

Auto-report when reprocessing results 

Automatic reporting is disabled by default when reprocessing results by clicking the “Reprocess” toolbar 
button, or the “Reprocess Results” option of the “File” menu.  If you check this option, then the automatic 
reporting options enabled in your configuration will be performed. 

Overriding Automatic Reporting 

Automatic processing can be overridden by checking or unchecking the “Auto-report” checkbox on the 
“Manual Data Entry” window that is displayed if you have custom sample information fields enabled or manual 
component amounts enabled. 

 

Report Control 

Check the “Print report for automatically processed results” box if you would like a report to be sent to the 
default printer when processing data automatically from a chromatography data system. 

By default, all components in the component table will be included in the report.  Check “Report only 
components with amount > 0” if you would like components with a raw amount of 0 to be excluded from the 
component results in the report. 

Check or uncheck, “Print Sample Information Results”, “Print Component Results”, “Print 
Summary/Total Results”, and “Print Errors and Warnings”, to include or exclude those sections of the 
report when printing or saving as a PDF file. 

Check “Report null instead of 0 if component amount not measured” if you are required to report a 
component amount of 0 only if the amount was measured.  EZReporter determines if a component has been 
measured if it is included in the results from the GC (even if the amount is 0), entered manually in the manual 
data entry window (even if the amount is 0), or is the result of a calculated result.  If this option is enabled and 
the component amount has not been measured, then a null (blank) is reported instead. 

 

PDF File Control 
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These settings allow an Adobe Acrobat, “PDF” version of the report to be saved to a specified folder when 
processing results automatically.  To enable this option check, “Save PDF file when processing results”. 

Save PDF File to Folder:  Click the “Open” button to select the directory to which the “PDF” files will be 
saved. 

PDF File Name:  These options are used to specify the PDF file name.  You can choose to name the PDF file 
based on the name of the EZReporter data file (see the “Data Files” tab), or you can enter a “fixed” file name.  
If you choose the first option, the PDF file will have the same base file name as the EZReporter data file.  You 
can also have the export file named based on the sample name from the chromatography data system. 

Note:  If you select the “Use fixed file name” option, you can use result variables to further customize the file 
name.  For example, if you enter the fixed file name, {SampleName}-{InjectionTime}, the file name would be 
changed to the actual sample name and injection time. 

Post Processing Program 

You can specify an external program to run after all processing has completed.  You can specify optional 
parameters to pass to the program when it runs.  The command-line options can include variables like 
{ExportDirectory} and {ExportFile}. 

For example, if you have Microsoft Excel installed on your computer, you can enter the following program and 
options to open the exported text file in Excel automatically at the end of the run: 

Post Run Program:  Excel.exe 

Options:  "{ExportDirectory}\{ExportFile}" 

NOTE:  The quotation marks are required if there are any spaces in the directory path or file name. 

Report Format 

Use the “Report Format” panel to change the report margins, to append custom text at the end of the report, 
or to add a logo to the top of the first page of the printed report. 
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Report Margins 

You can set the margins of the printed report in inches in order to make space for letterhead or logo, or to 
increase or decrease the number of lines printed on each page. 

Note:  The minimum left/right margin you can set is 0.25”. 

Customize Result Order 

You can edit the order of results displayed in the Sample Information, Component Results, and Summary 
Results tables.  You must first check "Allow results to be re-ordered by dragging rows or columns" option and 
then save the configuration file: 
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Then right-click the desired table in the Sample Results tab of the main EZReporter window, and choose the 
"Change Result Order" option from the pop-up menu: 

 

Finally, left-click either the column header (component table) or result caption (sample information or 
summary results table) and drag it to the new desired location in the table. 

 

 

The custom result order is saved with the currently loaded configuration file.  Make sure to disable this option 
in each table when you are finished by right-clicking "Change Result Order" again.  This option is also 
automatically disabled when you restart EZReporter, process results, or load a configuration file. 

Append Text File to Report 

This option allows you to append additional custom text to the bottom of the main report – below the 
total/summary results table.  You can either edit the file “additional.txt” by clicking the Notepad icon, or browse 
and select a different file containing the desired text.  You can also choose whether the text is left, center, or 
right aligned on the report page and you can also select the font that will be used. 

Note:  This additional text is only included in the printed report.  It is not displayed on screen. 

Report Logo 

You can add a logo graphic to the printed report.  The following file formats are supported: JPEG, TIF, BMP, 
PNG, and GIF.  Click the “Load Logo” button to select and load a logo file from disk.  The logo is printed at the 
top of the first page of the report between the header and the report title.  It can be aligned to the left margin, 
page center, or right margin.  You can also specify a height or width (in inches) and the logo will be scaled 
proportionally (the height/width aspect ratio of the graphic will be maintained so that the logo isn’t distorted).  
If you specify the height and width as “0” then the logo will be printed at the original dimensions and 
resolution. 

Note:  The logo graphic is stored in the configuration file.  To prevent your configuration file from becoming 
too large, we recommend using the smallest logo that will meet your needs.  
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Report Titles and Fonts 

Use the “Report Titles and Fonts” table to modify the titles, captions, and other labels that are displayed in the 
displayed/printed report. 

 

Context Menu 

Right-click the Report Titles and Fonts table for the following additional options in the context (popup) menu: 

Edit Selected Font:  Edit the font for the selected report item. 

Edit Report Table Caption Fonts:  Edit the Table Caption font for the Sample Information, Component 
Results, Summary Results, and Errors and Warnings tables in the report. 

Edit Report Table Header Fonts:  Edit the Table Header font for the Sample Information, Component 
Results, Summary Results, and Errors and Warnings tables in the report. 

Edit Report Table Fonts:  Edit the Table body font for the Sample Information, Component Results, 
Summary Results, and Errors and Warnings tables in the report. 

Print Page Numbers 

To have page numbers included on the printed report, you can add the following special “tokens” to the 
Footer Text: 

Current page number:  [PageNo] 

Total page Count:  [PageCount] 

For example: 

Page [PageNo] of [PageCount] 
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Print Report Date and Time 

To print the report date in the report header or footer, you can include the {Now} variable.  Use a format string 
to specify the format: 

• Date Only: {Now,,MM/dd/yyyy} or {Now,,yyyy-MM-dd} 

• Date & Time:  {Now,,yyyy-MM-dd  hh:mm:ss} 

See “Export Template Format” on page 61 for a list of variable format characters and how they can be used. 

Reported Results 

The reported results table lists all of the possible results that can be included in the displayed/printed report.  
The table is divided into three sections:  sample information at the top, component results that will be 
displayed in the component table next, followed by total/summary results.  To include a particular result in 
your report simply check the checkbox in the “Report” column.  Results that have been selected for the report 
are highlighted in yellow. 

 

You can change the text of the labels that identify a result on the report, set the formatting of numeric results, 
and add/remove a result from the report. 

Note that the “|” character is converted into a line break when the labels are rendered onto the report.  This is 
particularly useful for component results when you want to minimize the width of the component result 
column. 

Format 

You can set the numeric formatting for a result by entering a format string in the corresponding field.  
Examples of common formatting strings are shown in the table below. 
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Important:  The format of component and related total amount results is determined by the “Component 
Amount Precision” setting (see “Component Amount ” on page 66).  You are not able to customize the format 
of those results. 

 

Format String Result 

0 Will display all digits to the left of the decimal point and no digits to the right: 
The value 10000.2324 will be displayed as 10000 
The value 0.2324 will be displayed as 0 

0.00 Will display all digits to the left of the decimal point and two digits to the right of the 
decimal place: 
The value 232.4012 will be displayed as 232.40 
The value 232 will be displayed as 232.00 

0.0### Will display all digits to the left of the decimal place, and from 1 to 4 digits to the right 
of the decimal place: 
The value 232.4012 will be displayed as 232.4012 
The value 232.4 will be displayed as 232.4 
The value 232 will be displayed as 232.0 

Context Menu 

If you right click anywhere on the report/result table, the following context menu options will pop up: 

Select all results:  Check all of the results currently displayed in the table. 

Select no results:  Uncheck all of the results currently displayed in the table. 

Select default results:  Check only the results that are included in the default configuration. 

Reset report labels to default values:  Resets all of the report labels to their original, default value. 
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Sample Processing 

Sample Processing Overview 
You manage the processing of results from instruments (chromatography data systems) using the “Sample 
Processing” tab of the main window. 

Note:  The Data Analysis Edition of EZReporter does not include a license for processing, so this tab and its 
functionality aren’t available. 
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See also: 

Instruments 

Processing Control 

Sample Processing Log 

Instruments 
Except for the Data Analysis Edition, most EZReporter editions include a license for processing results from 
one instrument (contact Diablo Analytical for information on multi-instrument licenses).   

 

To process results from an instrument, you must first click the “Add” button to add an instrument and then 
configure the Data System Connector plugin for your specific chromatography data system. 

Add/Edit Instrument 
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Instrument Name 

Enter a descriptive name for this instrument.  This name will be displayed in the instrument table. 

Data System Connector 

In order to process results from your chromatography data system, you must select the correct Data System 
Connector plugin for the data system you are using, and then “Edit” the connector to select and apply any 
connector-specific settings.  Please refer to the reference manual or help file for the particular Data System 
Connector you are using. 

Important: The data system connectors available for you to select will depend on which version of the 
installation program you used to install the EZReporter 4.0 software.  Make sure that you download the 
installer that includes support for the chromatography data system you are using to control your gas 
chromatograph. 

The following is an example of a generic Data System Connector settings window.  The settings window for 
your instrument/data system may be different. 
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Configuration File Mode 

The Configuration File Mode settings allow you to customize the configuration file that is used to process 
results from the instrument. 

Use Active EZReporter configuration file 

If you choose this option, then EZReporter will use whatever configuration file is currently loaded to process 
results from this instrument. 

 

 

Load Default Instrument configuration file 

This option allows you to select a specific configuration file to be loaded whenever processing results from 
this instrument. 
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Use Rules to select configuration file 

This option allows you to specify a set of rules to determine which configuration file will be loaded when 
processing results from this instrument.  Rules are processed in the order listed.  If none of the rules match, 
then the default instrument configuration file is loaded. 
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Parameter:  You can base the rule on the Sample Name, Method File, Sample Comments, or User Name. 

Condition:  Rule conditions include, “Equals” (the parameter matches the condition text exactly), “Contains” 
(the parameter contains the condition text), “Starts With” (the parameter starts with the condition text), “Ends 
With” (the parameter ends with the condition text), and “Is Like” (use pattern matching): 

The pattern-matching features allow you to match each character in the parameter against a specific 
character, a wildcard character, a character list, or a character range in the condition text. The following table 
shows the characters allowed in pattern and what they match. 

 

? Any single character 

* Zero or more characters 

# Any single digit (0–9) 

Condition Text:  The text string that is used for the comparison with the parameter. 

Load Configuration File:  The configuration file that will be loaded of the rule is a match. 

Monitor Instruments 

In order for EZReporter to monitor the configured instruments for results you need to check this checkbox.  It 
is unchecked by default when you start EZReporter.  If you would like EZReporter to begin monitoring 
instruments automatically when it starts, you can set the option in the Processing Control configuration. 

Processing Control 

 

Processing of results that have been added to the sample log table is managed using the “Processing 
Control” settings.  Sample processing is performed in the order samples are added to the log table, and the 
table is checked for new samples on the sample processing interval specified in the Processing Control 
Settings. 

Configure Processing 

Click the “Configure” button to configure the Processing Control Settings. 
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Automatically Start Instrument Monitoring:  If this checkbox is checked, instrument monitoring will be 
enabled automatically whenever the EZReporter software starts.  If you leave it unchecked, you will have to 
manually check the “Monitor Instruments” option in order to start monitoring instruments for results. 

Maximum Samples in Processing Queue:  In order to conserve memory and system resources, 
EZReporter only keeps the number of samples specified here in the processing queue (log table).  When this 
maximum value of samples is reached, the oldest sample in the table will be deleted each time a new sample 
is added. 

Sample Processing Interval:  This is the interval, in milliseconds, that the processing queue/log table is 
checked for new samples.  Leave it at the default value of 2000 milliseconds (2 seconds) unless you have a 
specific need. 

Sample Processing Log 
If you enable instrument monitoring and your instrument is connected, then new samples will be displayed in 
the Sample Processing Log table as they are received from the instrument/chromatography data system.  
Sample results are processed and reported automatically in the order they are received. 
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Entering Sample Information 

If you have custom sample information fields defined in your configuration, the “Manual Data Entry” window 
will be displayed automatically each time a sample is processed (unless you have disabled it in the 
configuration).  Enter or update any required sample information and then click the “Process” button to 
process the results.  If you click “Cancel” the sample will not be processed and the status will be displayed as 
“Aborted” in the Sample Log Table. 
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Auto-report 

If this checkbox is checked, all reporting options specified in the configuration will be performed.  If it is 
unchecked the calculations will be performed, and the main UI will be updated, but you will have to manually 
print the report, save the report to a PDF file, export results to a text file, etc.  See “Report Control” on page 
70 for more information on automatic reporting. 

Entering Component Amounts 

If you have any of the components in your configuration have the “Manual Amount Entry” option checked, 
then the Manual Data Entry window will also include a “Component Amounts” tab.  Switch to this tab to 
manually enter those component amounts. 

Note:  When processing results from an instrument, you will only be able to update those component amounts 
that have the “Manual Amount Entry” option checked. 

The component raw amounts displayed in the manual data entry window are initialized to null/blank values if 
they have not been measured yet. Values that have been measured, for example from the results of the GC 
analysis, will be initialized to the measured value.  If an unmeasured value is entered manually, it will then be 
determined to have been measured (even if the value entered is 0).  If a value is entered accidentally by 
entering the cell, it can be cleared using a new context menu option. "Clear raw amount".  The component 
measured status is used to determine whether to report or export 0 values or null/blank values if those options 
are enabled.  See “Export Control” on page 57 and “Report Control” on page 70 

Reviewing and Reprocessing Raw Results 

You can review the “raw” sample results generated by the chromatography data system by double-clicking 
the desired sample in the Sample Processing Log or by clicking the “File > Display Raw Results” menu 
option for the current result.   

The “Display Raw Results” window allows you to view the sample information, peak results, and sample tags 
provided by the chromatography data system, and the processing log generated by the data system 
connector. 
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To reprocess the raw results, select the desired “Processing Option” and then click the “Process” button.  
The raw results will then be re-submitted to EZReporter for reporting using the configuration file specified by 
the Processing Option you selected. 

You can also save the raw results to an EZReporter data file by clicking, “Save As…”, and if your raw results 
contain the original configuration file used to process results, you can extract that configuration file and save it 
to disk by clicking, “Extract…”. 

 

Raw Sample Information 

The Summary tab contains the Sample Information as reported by the chromatography data system and 
instrument connector. 

 

Raw Peak Results 

The Peak Results tab contains the raw component/peak results as reported by the chromatography data 
system. 
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This information can be very helpful when troubleshooting issues with component results.  For example: 

• Missing or Mismatched Peak Names:  EZReporter identifies components by the peak/component 
name.  If a peak name reported in the raw peak results is not present in the EZReporter component 
table, it will be ignored.  Similarly, if the a peak name in the raw results is spelled differently than the 
corresponding component name in the EZReporter component table, it will be ignored and 
EZReporter will report a raw amount of 0 for that component. 

• Duplicate Peak Names:  If there are multiple peaks with the same name in the raw peak results, 
EZReporter will use the results from the last peak in the table.  If you need to use the results from a 
specific peak, then change the names of those duplicate peaks in the GC method calibration/peak 
table so they are unique, and then set the component name in the EZReporter component table to 
match the name of the desired peak name. 

• Amount is Zero:  If the amount for a particular peak is 0 in the raw peak results and you expect it to 
be non-zero, then this generally indicates an issue with integration or calibration of your GC method. 

Sample Tags 

Some of the EZReporter data system connectors provide additional sample “tags” from the results provided 
by the chromatography data system.  These tags are not available from every data system and the available 
tags may change based on your data system method settings.  These sample tags can be mapped to custom 
sample information fields for display in your report or to be exported to text files.  See “Sample Information” on 
page 40 for more information about using sample tags with custom sample information fields. 
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Processing Log 

The Processing Log contains information logged by the instrument connector when processing the raw results 
provided by the chromatography data system.  This information can sometimes be helpful when 
troubleshooting errors or other issues. 
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Other Procedures 

Back Up the Configuration 
It is important to back up your EZReporter configuration whenever you make a significant change.  To back 
up your current configuration, click the “Tools > Backup EZReporter Configuration” menu option. 

 

You can choose to include the results database file and all configuration files in the settings folder (by default, 
only the current configuration file is backed up).  These options are recommended if you use more than one 
configuration file, and if you have licensed and are using the Results Database module. 

The backup function will save all the important EZReporter instrument, initialization, settings, and other files to 
a backup “Zip” file.  The backup file is named, ‘ezreporter.backup.yyyymmdd-hhmmss.zip’, where ‘yyyymmdd’ 
is the current year month and day, and ‘hhmmss’ is the current hour, minute, and second of the day.  By 
default, the backup file is saved to the EZReporter “Backup” folder, however, you can specify the Windows 
desktop or another folder if you choose. 

Configuration Files Backed Up 

The following table contains a summary of the configuration files that are included in the backup. 

 

Folder/File Description 

Instruments C:\ProgramData\Diablo Analytical\EZReporter\Instruments 
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instruments.xml The instruments configuration file. 

Instruments\instrumentN C:\ProgramData\Diablo 
Analytical\EZReporter\Instruments\instrumentN 

instrument.xml Contains the general instrument settings for instrument “N” 
(1,2,3, etc.). 

Diablo.EZReporter.Connectors.*.xml Contains the connector-specific settings for instrument “N” 
(1,2,3, etc.). 

Settings C:\Users\Public\Documents\Diablo EZReporter\Settings 

*.cfgx EZReporter configuration files.  Only the currently loaded 
configuration file is saved to the backup unless you select 
the “Include all configuration files in the Settings folder” 
option. 

*.sampleinfo.xml The file containing the last values entered for the custom 
sample information fields for the corresponding 
configuration file. 

Common Documents C:\Users\Public\Documents\Diablo EZReporter 

Results.db The Results Database file.  This file is only included in the 
backup if selected in the backup options. 

Modbus.xml The file containing all the Modbus slave server settings. 

EZX*.SerialCode.xml A text file containing the serial code for the activated 
license, where “EZX*” is the corresponding serial number.  
This file is created automatically when the backup is 
saved. 

ResultComments.dat Contains the list of comments that are loaded into the 
result comments list box in the “Confirm Results” window 
for text export or the results database. 

Program Data C:\ProgramData\Diablo Analytical\EZReporter 

EZReporter.xml The EZReporter initialization file.  It contains form entries, 
window sizes and locations, and other information that is 
used to initialize EZReporter’s windows and forms. 

samplecount.xml Stores the total number of samples processed by 
EZReporter and the number of samples processed using 
each configuration file. 

ProcessingQueue.xml Stores the settings for the Sample Processing Control and 
Queue. 

parameters.xml Stores additional settings used by EZReporter. 

componentaliases.dat Contains the component name “aliases” (synonyms) used 
by some of the functions in the component settings of the 
configuration editor. 

*.txt, *.txt.1, *.txt.2 The EZReporter log files.  These files are saved to the 
backup file for troubleshooting purposes. 
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Restore the Configuration 
To restore the files from an EZReporter backup Zip file, click the menu option, “Tools > Restore EZReporter 
Configuration”.  Select the backup Zip file containing the configuration files that you wish to restore.  After the 
backup zip file is opened, the list of files available in the Zip file to restore is displayed in the backup file list.  
By default, all the files will be selected to restore.  You can check or uncheck any of the individual files in the 
file list to include or exclude them from the restore procedure.  You can also right-click the file list and click, 
“Select All” or “Select None” from the pop-up menu.  Finally, the files are listed under the folder to which they 
will be restored: “Instruments”, “Settings”, Program Data”, and “Common Documents”.  You can check or 
uncheck the bold folder heading in the list to check or uncheck all the files listed under that folder. 

 

Finally, you can choose whether you want to back up the current configuration before restoring the selected 
files from the backup zip file.   

Click the “Restore” button to begin the restore procedure.  Upon completion, a summary will be displayed, 
and you will have the option to view the detailed restore log file.  Close and restart EZReporter to ensure that 
the restored configuration will be used. 

Important Considerations 

1) The selected files will be restored to their original location.  If a file exists with the same name in the 
current configuration, it will be over-written. 
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2) The backup and restore procedures do not include EZReporter data files in the “Data” folder.  You 
should back these up manually. 

Transfer the License and Configuration 
You can transfer an existing EZReporter license and configuration to a new computer using the following 
procedure. 

Important Notes: 

• You can restore a backup to a computer running the same version or a newer version of EZReporter.  
However, you will potentially run into problems if you try to restore a backup created with a newer 
version of EZReporter to a computer running an older version of EZReporter.  The results database 
may be incompatible with the older version, and you may lose features that aren’t present in the older 
version. 

• When you install EZReporter on the new computer, make sure the version you are installing is 
compatible with the software support expiration date for your license.  Click, “Help > License Status” 
to determine your software support status. 

You will need the following: 

1) An EZReporter backup zip file containing the configuration you want to transfer to a new computer. 

2) The serial number and serial code for the license you want to transfer to a new computer. 

3) An EZReporter installation program that is compatible with your software support expiration date, and 
which includes the connector plugins for the GC / data system you will be using 

Transfer Procedure 

1) Create a backup of the EZReporter configuration from the old computer. 
 
See “Back Up the Configuration” on page 91.  Make sure to include the results database if you have 
licensed the Results Database module, and check the option to include all configuration files in the 
settings folder if you use more than the currently loaded configuration file. 

2) Save your EZReporter serial number and serial code. 
 
Click, “Help > License Status”.  The serial number and serial code are displayed in the license status 
window. 
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Note:  As of EZReporter version 4.0.15.0 a text file containing your serial code is saved to the 
“Common Documents” folder and included when you back up the EZReporter configuration. 

3) Install a compatible version of EZReporter on the new computer. 
 
If your software support has not expired, you can download the installer for the latest version of 
EZReporter on our web site: 
 
https://diabloanalytical.com/products/software/ezreporter/ezreporter-downloads/ 
 
Make sure to download the version of the installer that includes the connector plugins for the GC and 
chromatography data system you are using.  When in doubt, download the complete version of the 
installer that includes the connector plugins for all supported data systems. 
 
If the software support for your license has expired, please contact Diablo Analytical either to renew 
software support, or to send you a download link for a version of the installer that is compatible with 
the support expiration date.  You will need to provide your software serial number. 

4) Restore the configuration from the backup Zip file you created in Step 1 to the new computer 
 
See “Restore the Configuration” on page 93 
 
Close and restart EZReporter after restoring the configuration. 

5) Confirm the configuration is working correctly on the new computer. 
 
When you first install EZReporter on the new computer it will be running in fully functional trial mode 
for up to 30 days.  So, you can confirm that everything is functioning correctly before deactivating the 
old computer. 

6) Deactivate the license on the old computer 
 
Click, “Help > License Status” and then click the “Deactivate” button: 
 



Other Procedures 

96 Diablo EZReporter 4.0 Reference Manual 

 
 
Alternatively, contact Diablo Analytical and we can deactivate the license manually for you.  You will 
need to provide the EZReporter serial number or serial code. 

7) Activate the license on the new computer 
 
Click, “Help > License Status” and then click the “Activate License” button.  Enter your 31-character 
serial code into the activation Window or use the small “Load” button at the bottom of the activation 
window to load the serial code from a text file.  Then, click the “Apply” button to activate he license 
over the Internet. 
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